Before using this software, please carefully read these instructions completely and keep these operating instructions in a safe place for future reference.
The following trademarks and registered trademarks are used throughout this manual:

Microsoft, MS-DOS, Windows, Windows Server, Windows Vista and Internet Explorer are either registered trademarks or trademarks of Microsoft Corporation in the USA and other countries. Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
i386, i486, Celeron, Intel Centrino, Pentium and Itanium are trademarks of Intel Corporation and its subsidiaries.
Mac, Mac OS, Macintosh, TrueType and Apple are trademarks of Apple Inc., registered in the U.S. and other countries.
The USB-IF Logos are trademarks of Universal Serial Bus Implementers Forum, Inc.
Novell, NetWare, IntranetWare, NDS are registered trademarks of Novell, Inc. in the USA and other countries.
PEERLESSPage™ is a trademark of the PEERLESS Systems Corporation; and,
PEERLESSPrint® and Memory Reduction Technology® are registered trademarks PEERLESS Systems Corporation; and, COPYRIGHT © 2005 PEERLESS Systems Corporation.
COPYRIGHT © 2005 Adobe Systems Incorporated. All Rights Reserved; and
Adobe® PostScript® 3™. Universal Font Scaling Technology (UFST) and all typefaces have been licensed from Monotype Imaging Inc.
Monotype® is a registered trademark of Monotype Imaging Inc. registered in the U.S. Patent and Trademark Office and may be registered in other jurisdictions.
ColorSet™ is a registered trademark of Monotype Imaging Inc. registered in the U.S. Patent and Trademark Office and may be registered in other jurisdictions. ColorSet™ Profile Tool Kit, Profile Studio and Profile Optimizer are trademarks of Monotype Imaging Inc. and may be registered in certain jurisdictions.
COPYRIGHT © 2007 Monotype Imaging Inc. All Rights Reserved.
PCL is a trademark of Hewlett-Packard Company.
Adobe, Acrobat, Adobe Reader, Adobe Type Manager, PostScript, PostScript 3 and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
All other product/brand names, trademarks or registered trademarks identified herein are the property of their respective owners.
In these Operating Instructions, some ™ and ® marks are omitted from the main text.

© Panasonic Communications Co., Ltd. 2006-2008
Unauthorized copying and distribution is a violation of law.
Published in Japan.
The contents of these Operating Instructions are subject to change without notice.
Table of Contents

General Description ..................................................... 4

Printing from Windows Applications ...................... 6
- Basic Operation ..................................................................................................................6
- Configuring the Printer Driver Settings .................................................................7
- Job Status Utility ........................................................................................................20
- Mailbox ..........................................................................................................................24
  Mailbox Printing (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213) ..................26
- Job Control (Output Queue) (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213) ...28
- Mailbox Printing (For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330) ..................30
- Job Queue (For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330) .........................31
- Mailbox Printing (For DP-8020E/8020P*, DP-180/190, UF-9000) ..................................32
- Secure Mailbox (For DP-8020E/8020P*, DP-180/190, UF-9000) ...................................34
- Job Queue (For DP-8020E/8020P*, DP-180/190, UF-9000) ........................................36

Printing from Macintosh Applications ................. 38
- Basic Operation .................................................................................................................38
- Configuring the Printer Driver Settings (For Mac OS 8.6/9.x) ........................................44
- Configuring the Printer Driver Settings (For Mac OS X) ...........................................54

Appendix ................................................................. 76
- Specifications (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213) .................76
- Specifications (For DP-8060/8045/8035) ..................................................................77
- Specifications (For DP-8032/8025) ........................................................................77
- Specifications (For DP-3030/2330) ........................................................................78
- Specifications (For DP-8020E/8020P*) .................................................................78
- Specifications (For DP-180/190, UF-9000) ..........................................................79
- Printing Area ..................................................................................................................80
- PostScript® Font List .................................................................................................81

Troubleshooting ....................................................... 82
- Printing Operation Failure .........................................................................................82
- Documents Not PrintingCorrectly .......................................................................83
- Error Messages Displayed on the Computer .......................................................84
- Error Messages Displayed on Your Machine
  For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213 .......................................85

NOTE
- DP-8020P is not available for the USA and Canada.
- Model availability depends on the destination country.
General Description

This manual describes how to configure print settings, and how to use the convenient and advanced functions of the PostScript® 3™ Printer Driver.
For PostScript® 3™ Printer Driver details, and advanced function configuration, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)".

Printing from Windows application

1. Basic Operation
   Describes the print dialog box when printing from the application software.

2. Configuring the Printer Driver Settings (Configuring from Properties screen)
   Describes how to configure the application software's print settings. For Windows® the following two methods are available. (Although both methods can configure similar settings, this manual will only explain the method (1) below.)
   (1) Right-click on the printer icon, and then select Printing Preferences in the pop-up menu to configure the print settings. (Page 7)
      · The configured print settings are common settings for all application software being used.
   (2) Select Properties from the application software's Print Settings screen to configure the print settings.
      · The configured print settings can be changed individually from each application software being used.

3. Advanced Settings
   (1) Job Status Utility
      The Job status utility displays when the printing job is completed on a network connected Panasonic printer. (Page 20)
   (2) Mailbox
      If the hard disk drive is installed, the Printing data can be saved on the hard drive for later printing. (Page 24) User ID and Password are required when printing from the Hard Disk Drive. Thus, Mailbox print is suitable for printing confidential documents.

Printing from Mac® application

1. Basic Operation

2. Configuring the Printer Driver Settings (Configuring from Print setting screen)
   Configures the necessary print settings from the pull down menu. (Pages 44 and 54)
   Depending on the Mac OS® version being used, some settings may be restricted and not configurable.

3. Mailbox
   Same as Windows.
Printing from Windows Applications

Basic Operation

If the printer driver is properly installed, and setup as the default printer, it's a simple operation to print on it from any Windows application.

To print from most Windows applications, use the Print command in the File menu.

Selecting the Print command typically displays the following Print dialog box:

Setup your preferred configuration (Page range, Number of copies, etc.) first, and then click the OK button to start printing.

Note:
If more than one printer is installed on your PC, follow the steps below to set a default printer:
1. Click the Start button, select Printers and Faxes icon (For Windows 2000: Click the Start button, select Settings, and then click the Printer icon. Windows Vista: Click the Start button, select Control Panel, and then click the Hardware and Sound : Printer.).
2. Right-click on the desired printer icon, and then select Set as Default Printer in the popup menu. The check mark next to the printer icon denotes a Default Printer.
Configuring the Printer Driver Settings

Opening the Printing Preferences Dialog Box

To change the printer settings, open the dialog box for the printer properties by performing the following steps.

1. Click the Start button, select Printers and Faxes icon. (For Windows 2000: Click the Start button, select Settings, and then click the Printers icon. Windows Vista: Click the Start button, select Control Panel, and then click the Hardware and Sound : Printer.)

2. Right-click on the desired printer icon in the Printers and Faxes (Printers) folder, and then select Printing Preferences... in the pop-up menu.
3 The Printing Preferences... dialog box appears.

DP-C405/C305/C265:

1. Select the Layout or the Paper/Quality tab.

2. Click the Advanced... button.

(see pages 11-12)

(see pages 13-19)

(scroll the dialog box)

DP-C354/C264/C323/C263/C213:

1. Select the Layout or the Paper/Quality tab.

2. Click the Advanced... button.

(see pages 11-12)

(see pages 13-19)

(scroll the dialog box)
DP-8060/8045/8035:

1. Select the **Layout** or the **Paper/Quality** tab.

2. Click the **Advanced...** button.

(see pages 11-12)

DP-8032/8025, DP-3030/2330:

1. Select the **Layout** or the **Paper/Quality** tab.

2. Click the **Advanced...** button.

(see pages 11-12)

(see pages 13-19)

(scroll the dialog box)
DP-8020E/8020P*

1. Select the Layout or the Paper/Quality tab.

(see pages 11-12)

2. Click the Advanced... button.

(see pages 13-19)

DP-180/190, UF-9000

1. Select the Layout or the Paper/Quality tab.

(see pages 11-12)

2. Click the Advanced... button.

(see pages 13-19)
1. **Orientation**
   - Portrait: prints portrait documents.
   - Landscape: prints landscape documents.
   - Rotated Landscape: prints documents rotated 90 degrees.

2. **Print on Both Sides**
   - None: prints on one side.
   - Flip on Long Edge/Long Side: prints on both sides so that the paper is spread at the center of the longer edge.
   - Flip on Short Edge/Short Side: prints on both sides so that the paper is spread at the center of the shorter edge.

3. **Page Order**
   - Front to Back: prints so that the first page is at the top of the printed sheets.
   - Back to Front: prints so that the first page is at the bottom of the printed sheets.

4. **Pages Per Sheet / Page Format**
   - Prints multiple pages of the document on a single sheet.
   - 1: prints a single page of the document on a single sheet. (default)
   - 2, 4, 6, 9, 16, Booklet, Draw Borders: See below.
Paper/Quality tab, Page Setup/Advanced tab

Tray Selection

1. **Paper Source**: specifies the printing paper (paper tray).
   - Automatically Select: loads paper from the paper tray where the selected paper is set (paper tray/Multi-Purpose Tray). When the paper of the same size is set in the multiple paper trays, paper is preferentially loaded from the upper tray.
   - Multi-Purpose Tray: loads paper from the Multi-Purpose Tray.
   - Tray 1 to Tray 4: loads paper from the specified paper tray (paper tray).

2. **Media**: specifies the type of paper.
   - Specifies when setting the special paper such as thick paper in the paper tray/Multi-Purpose Tray.

**Note:**
Specifies the type of paper. Paper Feed method (Tray or Multi-Purpose Tray) differ depending on the **Media (Plain Paper, Thick Paper, etc.)** selected. See below for the **Media**.

(For DP-C405/C305/C265)

(For DP-C354/C264/C323/C263/C213)

(For DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000)
Plain Paper, Thick Paper

(For DP-8020E/8020P*)
Plain Paper, Thick Paper, Transparency, Envelope

(For DP-180/190, UF-9000)
Plain Paper, Thick Paper, Transparency, Label, Cotton Paper, Envelope
Advanced Settings

DP-C405/C305/C265:

1. AdobePS Panasonic DP PS Advanced Document Settings
2. Print Quality: Standard
3. Advanced Printing Features: Disabled

DP-C354/C264/C323/C263/C213:

1. Panasonic PS Advanced Document Settings
2. Print Quality: Standard
3. Advanced Printing Features: Disabled

(Scroll the dialog box)
Printing from Windows Applications

DP-8060/8045/8035:

1. (scroll the dialog box)

2. (scroll the dialog box)

3. (scroll the dialog box)

DP-8032/8025, DP-3030/2330:

1. (scroll the dialog box)

2. (scroll the dialog box)

3. (scroll the dialog box)
Printing from Windows Applications

DP-8020E/8020P*:

1. Paper/Output
   - Media: Letter
   - Copy Count: 1 Copy

2. Graphic
   - Print Quality: Fine
   - Scaling: 100%
   - TrueType Fonts Substitute with Device Font

3. Document Options
   - Advanced Printing Features: Enabled
   - PostScript Options:
     - Sort Method: Sort
     - Secure Jobs
     - Print Black Pages: On
     - Print Cover Page: None
     - Back Cover Page: None

4. OK Cancel

DP-180/190, UF-9000:

1. Paper/Output
   - Media: Letter
   - Copy Count: 1 Copy

2. Graphic
   - Print Quality: Fine
   - Scaling: 100%
   - TrueType Fonts Substitute with Device Font

3. Document Options
   - Advanced Printing Features: Enabled
   - PostScript Options:
     - Sort Method: Sort
     - Secure Jobs
     - Print Black Pages: On
     - Print Cover Page: None
     - Back Cover Page: None

4. OK Cancel
The following items of the advanced settings screen are the inherent Panasonic setting items. For other items, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)*.

1. Paper/Output
(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

| Paper Size | 12×18, A3, A4, A5, B4 (JIS), B5 (JIS), Env #10, Env C5, Env DL, Env Monarch, Executive, FLS1 8×13, FLS2 8.5×13, Invoice, Ledger., Legal, Letter, PostScript Custom Page Size, Statement, Tabloid, Invoice |
| Copy Count | Specifies the number of print copies. |

(For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330)

| Paper Size | A3, A4, A5, B4 (JIS), B5 (JIS), FLS1 8×13, FLS2 8.5×13, INVOICE, Ledger., Legal, Letter, PostScript Custom Page Size, Statement, Tabloid |
| Copy Count | Specifies the number of print copies. |

(For DP-8020E/8020P*)

| Paper Size | A3, A4, A5, B4 (JIS), B5 (JIS), Env #10, Env DL, FLS1 8×13, FLS2 8.5×13, INVOICE, Ledger., Legal, Letter, PostScript Custom Page Size, Statement, Tabloid |
| Copy Count | Specifies the number of print copies. |

(For DP-180/190, UF-9000)

| Paper Size | A4, A5, B5 (JIS), Envi#10, Envi#9, Env C5, Env DL, Env Monarch, FLS1 8×13, FLS2 8.5×13, Invoice, Legal, Letter, PostScript Custom Page Size, Statement |
| Copy Count | Specifies the number of print copies. |

2. Graphic

Print Quality
Specifies the printing resolution.
(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

| Standard | Prints at a print engine resolution of 600×600 dpi. |
| Enhance | Prints at a print engine resolution of 1200×1200 dpi. |

(For DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000)

| 300×300dpi | Prints at a print engine resolution of 300×300 dpi. |
| 600×600dpi | Prints at a print engine resolution of 600×600 dpi. |
| 1200×600dpi | Prints at a print engine resolution of 1200×600 dpi. |

Note for DP-C405/C305/C265, DP-C354/C264/C323/C263/C213:
- Printing takes more time when Enhance is selected.
- Enhance is not available when the Media Type is set to Transparency.

Note for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000:
- Printing takes more time when 1200×600dpi is selected.

Scaling
Specify an enlargement or reduction percentage when printing documents. If enlargement/reduction can be set within the application software, indicate 100% here and specify the enlargement/reduction percentage in the Print dialog box of the application software.
3. Printer Features

Specifies the Finisher bin/Output tray.
(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

<table>
<thead>
<tr>
<th>Automatically Select</th>
<th>Automatically selects one of the following Output Trays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Tray</td>
<td>Sends printed jobs to the Inner tray.</td>
</tr>
<tr>
<td>Outer Tray</td>
<td>Sends printed jobs to the Outer tray.</td>
</tr>
<tr>
<td>Finisher</td>
<td>Sends printed jobs to the Finisher.</td>
</tr>
</tbody>
</table>

(For DP-8060/8045/8035)

| Bin 1                | Sends printed jobs to the Bin 1.                          |
| Bin 2                | Sends printed jobs to the Bin 2.                          |

**Note:**

- You can only select Bin 1/ Bin 2 for the output tray.

(For DP-8032/8025, DP-3030/2330)

<table>
<thead>
<tr>
<th>Auto Selection</th>
<th>Automatically selects one of the following Output Trays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Tray</td>
<td>Sends printed jobs to the Inner Tray 1 (Lower), Inner Tray 2 (Upper).</td>
</tr>
<tr>
<td>Outer Tray</td>
<td>Sends printed jobs to the Outer tray.</td>
</tr>
<tr>
<td>Finisher</td>
<td>Sends printed jobs to the Finisher.</td>
</tr>
</tbody>
</table>

**Note:**

- Finisher Bin/Output Tray is not available for DP-8020E/8020P*, DP-180/190, UF-9000.

**Sort/Sort Method**
Specifies how pages are sorted when multiple copies are printed.

<table>
<thead>
<tr>
<th>Non Sort (Stack)</th>
<th>Print individual pages in the specified quantity. For example, if you print three copies of a five-page document, the printer prints page 1 three times before printing page 2 and so on.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort</td>
<td>Copies are stacked in the order they are printed. Multiple copies are printed in separate sets in the specified quantity. For example, if you print three copies of a five-page document, the printer prints pages 1-5 three times.</td>
</tr>
<tr>
<td>Rotate Stack</td>
<td>Each set is rotated and stacked uniformly.</td>
</tr>
<tr>
<td>Rotate Sort</td>
<td>Each set is rotated and sorted.</td>
</tr>
<tr>
<td>Shift Stack</td>
<td>Each set is shifted and stacked uniformly.</td>
</tr>
<tr>
<td>Shift Sort</td>
<td>Each set is shifted and sorted.</td>
</tr>
</tbody>
</table>

**Note:**

- Shift is available only if the printer is equipped with a Finisher.
- Rotate is available only when Paper Source is set to Automatically Select.
- Rotate requires paper of the specified size to be loaded in two trays, loaded for Landscape and Portrait printing.
- Shift is not available for DP-8020E/8020P*.

**Staple**
Specifies the position of the staple. Choose the position from
Left 1, Left 2, Right 1, Right 2, Top 2 or Saddle Stitch (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213, DP-8060/8045/8035)
Left 1, Right 1 (For DP-8032/8025 and DP-3030/2330).

**Note:**

- Only available if the printer is equipped with an optional Finisher.
- Available staple position may be different depending on the Finishers.
The staple capacity differ depending on the types of Finisher and the paper size. Refer to Specifications in the Operating Instructions (For Basic Function) provided another booklet.

**Staple** is not available for DP-8020E/8020P*, DP-180/190, UF-9000.

Do not use **Stack, Rotate, and Shift**.

Some staple positions may not be available with certain punch position combinations. (For example, when selecting **TopRight** for the staple position and **Bottom** for the punch position.)

**Punch**

Specifies the hole punch position.

**Note:**
- **Photo Color** mode takes more time to print a file.
- Do not use **Shift Sort, Rotate Sort, Rotate Stack, and Shift Stack**.
- Some punch positions may not be available with certain staple position combinations. (For example, when selecting **TopRight** for the staple position and **Bottom** for the punch position.)

**Color Mode**

Specifies whether to print in color or grayscale.

<table>
<thead>
<tr>
<th>Color</th>
<th>Prints documents in color.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Color</td>
<td>Prints photos with the optimal settings.</td>
</tr>
<tr>
<td>Grayscale</td>
<td>Prints documents in monochrome.</td>
</tr>
</tbody>
</table>

**Note:**
- **Photo Color** mode takes more time to print a file.
- Some applications (data) may not be printed out in monochrome even if Black & White is selected under Color in Paper/Quality tab. In this case, change the color mode under Advanced to Black & White before printing.

**Color Management**

Specifies color settings to fine-tune color reproduction.

<table>
<thead>
<tr>
<th>Device Color</th>
<th>Choose this option to adjust the original color settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Select <strong>None</strong> when using ICM or application’s color management.</td>
</tr>
<tr>
<td>SWOP</td>
<td>Simulates printing to a standard American offset press.</td>
</tr>
<tr>
<td>Euroscale</td>
<td>Simulates printing to an European offset press.</td>
</tr>
</tbody>
</table>

**Note:**

**Device Color Space for Text / Graphics / Image**

Specifies color reproduction and Black output for text, graphics and images.

<table>
<thead>
<tr>
<th>Standard Profile with Black Gray</th>
<th>Print with color reproduction close to standard color monitors. Use only Black to reproduce intermediate shades of gray.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vivid Profile with Black Gray</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Use only Black to reproduce intermediate shades of gray.</td>
</tr>
<tr>
<td>Standard Profile with CMYK Gray</td>
<td>Print with color reproduction close to standard color monitors. Use the four colors of CMYK to reproduce intermediate shades of gray.</td>
</tr>
<tr>
<td>Vivid Profile with CMYK Gray</td>
<td>Use the four colors of CMYK to reproduce intermediate shades of gray. A good choice for line art and graphics.</td>
</tr>
</tbody>
</table>

**Note:**


Choose **On** to conserve toner. The overall effect is lighter, so this feature is recommended for test printing or producing documents for which appearance is not critical.

**Brightness (Available for DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)**

Color brightness is adjustable. 100% is normal brightness. Brightness darkens as the numerical value grows.
Secure
Printed documents can be saved on the printer’s hard disk drive (HDD) if the printer is equipped with one. Saved documents can be printed from the printer’s control panel. See “Mailbox Printing” on page 26.

<table>
<thead>
<tr>
<th>None</th>
<th>Mailbox printing is not applied.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Then Print</td>
<td>Allows you to print one proof set, before proceeding to print a large multi-set with various settings. The documents data will be deleted from the printer after printing.</td>
</tr>
<tr>
<td>Mailbox</td>
<td>Saves print data in the printer, in the mailbox specified by the User ID. The User ID must be entered to print documents saved in Mailbox. The document data will remain in the printer until it is deleted.</td>
</tr>
<tr>
<td>Secure Mailbox</td>
<td>Saves print data in the printer, in the mailbox specified by the User ID. The User ID and Password must be entered to print confidential documents saved in Secure Mailbox. The document data will remain in the printer until it is deleted.</td>
</tr>
</tbody>
</table>

Note:
- Using Mailbox printing requires that the Hard Disk Drive Unit is installed in the printer.

Print Blank Pages
Selecting this option will enable printing Blank pages.

Note:
- The Print Blank Pages is not selectable if the Print on Both Sides was enabled on the Layout/Page Setup tab.

Front/Back Cover or Front/Back Cover Page
You can configure the settings for cover pages. To use a cover page, select Front Cover/Front Cover Page or Back Cover/Back Cover Page, and specify the paper source to use for the Front and Back covers.

Duplex Notice
Check whether “2-Sided Print” is printed on the footer of 1st page when printing with 2-Sided Page style.

Note:
- This option is available only for DP-8032/8025, DP-3030/2330.
  The position where the notice is to be printed may differ depending on the Page Setup/ Orientation (Landscape) setting.
**Job Status Utility**

The **Job Status Utility** software will display the popup notice on your PC screen when finishing the Print, Copy, and Fax jobs.

The information displayed in the **Completion Notice** vary according to the type of job being performed.

■ **Completion Notice**

After a job completes, you will receive a notice like the one shown below on your PC screen.

**Print Completion Notice**

![Print Completion Notice](image)

Opens **Log** window.  
Opens **Setup** window.
Job Status Utility Log

To help you maintain of the sent or printed documents, the Job Status Utility is equipped to list the transaction result as a Log file. The latest 100 transactions are recorded on the log.

To start Job Status Utility Log window, click Log button on the Completion Notice window or right-click the Job Status Utility icon on the taskbar, and then select the Log from the menu.

The Job Status Utility Log window appears.

Note:
When the Job Status Utility icon is not on the taskbar, select Programs → Panasonic → Job Status Utility → Job Status Utility from the Start menu to activate the Job Status Utility icon.

Refreshes the Job Status Window
Opens the Select Printer Window (See Below)

Saves the displayed Log as a CSV format file.
(Only for Completed Job Status)

Deletes the Selected Print Jobs, or all Completed Jobs in the Log.

Chooses the printer name to monitor.

NOTE
Completion Notice does not appear if the device is connected with an USB or parallel cable.
Setup

You can pre-select the Completion Notice window display condition after job completion.

To start Setup window, click Setup button on the Completion Notice window, or right-click the Job Status Utility icon on the taskbar, and then select the Setup from the menu.

The Setup window appears.

Note:
When the Job Status Utility icon is not on the taskbar, select Programs ➔ Panasonic ➔ Job Status Utility ➔ Job Status Utility from the Start menu to activate the Job Status Utility icon.

1. Display Conditions
Selects under which condition to display the Completion Notice window.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Always display after each transmission.</td>
</tr>
<tr>
<td>Error only</td>
<td>Displays when an error occurs.</td>
</tr>
<tr>
<td>None</td>
<td>Do not display.</td>
</tr>
</tbody>
</table>

2. Display Completion Notice in front
Specify whether the Completion Notice window is displayed on the front of other windows.
When this option is not selected, the Completion Notice window is displayed in the back of other windows.
When the Completion Notice is displayed, the icon on the taskbar blinks.
Click the icon to bring the Completion Notice to the front of other windows.
Information displayed in the Completion Notice and the Job Status Utility Log. (See page 21)

<table>
<thead>
<tr>
<th>Status</th>
<th>Indicates the job status, such as completed, canceled, etc...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>Indicates information on an occurred error, such as information code, error message, etc...</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of job. The Completion Notice is used in common with PC Fax job, PC Print job, Copy job, and Fax job (Sent from the device).</td>
</tr>
<tr>
<td>File Name</td>
<td>Indicates the PC printed file name.</td>
</tr>
<tr>
<td>Page(s) (Print)</td>
<td>Indicates the number of pages of the PC Print job, and Copy job.</td>
</tr>
<tr>
<td>Page(s) (Fax)</td>
<td>Indicates the number of pages of the PC Fax job, and Fax job (Sent from the device).</td>
</tr>
<tr>
<td>Start Time</td>
<td>Indicates the start date and time of the job. The format of the date and time depends on the setting of your Windows PC.</td>
</tr>
<tr>
<td>Finish Time</td>
<td>Indicates the finish date and time of the job. The format of the date and time depends on the setting of your Windows PC.</td>
</tr>
<tr>
<td>Duration Time</td>
<td>Indicates the duration time of the job. (hh:mm:ss)</td>
</tr>
<tr>
<td>Fax Number/Email Address</td>
<td>Indicates the Fax Number, or Email Address (Fax job only) of the Fax transmission.</td>
</tr>
<tr>
<td>Destination Name</td>
<td>Indicates the registered Destination Name in the fax driver's phonebook when using the phonebook for transmitting a document.</td>
</tr>
<tr>
<td>Device Name</td>
<td>Indicates the Device Name registered in the device that is used for the fax transmission.</td>
</tr>
<tr>
<td>Device Location</td>
<td>Indicates the Device Location registered in the device that is used for the fax transmission.</td>
</tr>
<tr>
<td>Device IP Address</td>
<td>Indicates the Device IP Address that is used for the fax transmission.</td>
</tr>
<tr>
<td>User Name</td>
<td>Indicates the current executing job’s Department ID.</td>
</tr>
<tr>
<td>Machine Name</td>
<td>Indicates the current executing job’s Computer Name / IP Address.</td>
</tr>
</tbody>
</table>
Mailbox

To save printed documents into the printer’s mailbox for later printing, the printer must be equipped with the optional Hard Disk Drive. Saved documents can be printed from the printer’s control panel. The following three types of mailbox printing is available.

Check then Print: Saves print data in the printer, in the mailbox specified by the User ID. Allows you to print one proof set, before proceeding to print a large multi-set with various settings. The document data will be deleted from the printer after printing.

Mailbox: Saves print data in the printer, in the mailbox specified by the User ID. The User ID must be entered to print documents saved in the Mailbox. The document data will remain in the printer until it is deleted.

Secure Mailbox: Saves print data in the printer, in the mailbox specified by the User ID. The User ID and Password must be entered to print confidential documents saved in the Secure Mailbox. The document data will remain in the printer until it is deleted.

The PS Driver Security Utility adds User ID, Password, and Department Code information to print data that is printed using the PS Driver. This utility allows users to take advantage of the print job statistics, security and other advanced Panasonic printer functions.

Note:
- Check then Print function is not available for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000.

- This feature is available if the Hard Disk Drive Unit is installed in the printer unit, and the Hard Disk Drive Unit is set to Installed in Device Settings or Drive Options tab of the printer driver.
- Turning the Power Switch OFF while a print file is being stored into the Mailbox/Secure Mailbox may cause all files in it to be lost.
Saving a Print Job (from a PC)

1. Select **Print** in the **File** menu of the application.

2. Click the **PROPERTIES** button in the **Print** dialog box.

3. Click the **Device Options** or **Advanced...** tab, and then click Printer feature or Printer Feature.

4. Select types of mailbox printing method in the **Secure**.

   **Note:**
   *This feature is available if the **Hard Disk Drive Unit** is installed in the printer unit, and the **HDD Unit** is set to **Installed** in Device Settings or Device Options tab of the printer driver. Saves print data in the printer, in the mailbox specified by the **User ID**.

5. Click the **OK** button, and then the **OK** button to save the document data.
Mailbox Printing
(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

■ Printing or Deleting Mailbox Data

1 Press the Print key if set to other function mode.

2 Print display appears on the printer control panel. Enter the mailbox User ID number (up to 8-digit).

3 Select the OK button.

4 The total number of saved jobs in each mailbox is displayed. Select the desired mailbox.

5 The display shows the saved print jobs in the selected mailbox. Choose the job you want to print, and select the Print or Delete button.

Check then Print:

Mailbox:
Secure Mailbox only

Password display appears if Secure Mailbox is selected.
Enter the Password, and then select the OK button.

Check then Print, Mailbox, or Secure Mailbox
Select whether to delete the print job after printing.

Check then Print only
The number of copies is displayed. Enter the number of copies, and select the OK button to start printing.

Note: After having finished printing the Check then Print job, it will be deleted from the printer’s hard disk drive.
The **Job Control** menu of the printer control panel contains four buttons with the following functions.

- **On Line** button: Turns the printer on-line.
- **Off Line** button: Turns the printer off-line.
- **Cancel Print** button: Stops the current print job, and deletes the job from the output queue.
- **Output Queue** button: Checks the current print jobs.

This section describes how to use the **Output Queue** button to perform operations on the print jobs in the output queue.

1. Press the **Print** key if set to other function mode.
2. **Print** display appears on the printer control panel. Select the **Job Control** button.
3. Select the **Output Queue** button.
4. Displays a list of all pending output jobs that are usually processed on a first come first served basis. Select the **Print** tab.
5. Enter the password (4-digit), and then select the **OK** button.
Displays a list of current, and pending Print jobs. Select the print job you want to manage, and choose one of the following tasks to perform.

- **Select All** button: Selects all print jobs.
- **Delete** button: Deletes the selected job from the Output Queue.
- **Priority** button: Set or change the printing order of the selected job(s) in the Output Queue.
- **Close** button: Close the Output Queue display.
Mailbox Printing
(For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330)

1 Press the **Print** key on the Control Panel.

2 **Print** display appears on the Control panel. Enter the mailbox User ID number (up to 8-digit).

3 Select the **OK** button.

4 The total number of saved jobs in each mailbox is displayed. Select the desired mailbox.

5 The display shows the saved print jobs in the selected mailbox.
   Choose the job you want to print, and select the **PRINT** or **DELETE** button.

<table>
<thead>
<tr>
<th><strong>SELECT ALL</strong> button</th>
<th>Selects all print jobs. (Mailbox only)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CLOSE</strong> button</td>
<td>Closes the mailbox display.</td>
</tr>
</tbody>
</table>

**Mailbox:**

1

2

**Secure Mailbox:**

1

2

**Secure Mailbox only**
Password display appears if **Secure Mailbox** is selected.
Enter the **Password**, and then select the **OK** button.
Job Queue
(For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330)

1. Press the Print key on the Control Panel to select JOB QUEUE in the JOB CONTROL Tab, and then select the PRINT JOB QUEUE button.

2. Enter the password (4-digit), and then select the OK button.

3. Print Jobs
   Indicates all current and/or pending print jobs.

   2. SELECT ALL button
      Selects all print jobs.

   3. PRIORITY button
      Set or change the print job(s) priority.

   4. DELETE button
      Deletes print job(s).

   5. CLOSE button
      Closes this screen.
Follow the procedure below to print a file from a Mailbox on your machine.

1. Print a file to the Mailbox using the User ID.
   (Up to 20 mailboxes per each User ID)

2. Press PRINT.

3. Press FUNCTION, 1 and SET.

4. Enter the User ID (up to 8 digits) from the keypad.
   (Ex: 12345678)

5. Press SET.

6. Press repeatedly until the display shows the file you want to print.

7. Press SET.

8. 1 to print the displayed file.
    2 to print all files for the User ID.

9. Your machine will print the file. The file is automatically deleted after printing.
Deleting from the Mailbox

Follow the procedure below to delete a file from the Mailbox.

1. Press \textbf{PRINT}.
2. Press \textbf{FUNCTION} \(\mathbf{1}\) \textbf{SET}.
3. Enter the User ID (up to 8 digits) from the keypad. \textit{(Ex: 12345678)}
4. Press \textbf{SET}.
5. \^ or \_ repeatedly until the display shows the file you want to delete.
6. Press \textbf{SET}.
7. \(\mathbf{3}\) to delete the displayed file.
   \(\mathbf{3}\) to delete all files for the User ID.
8. Press \(\mathbf{3}\) \textbf{STOP}.

Note:
1. Turning the Power Switch OFF while a print file is being stored (DATA indicator lamp is flashing) into the Mailbox or Secure Mailbox may cause all files to be lost.
2. When using the Mailbox or Secure Mailbox feature, there is a limitation of 20 mailboxes per User ID. If more than 20 print jobs are sent to an User ID, jobs will be deleted from the memory. Jobs will also be deleted if the Hard Disk Drive Unit is full.
Secure Mailbox (For DP-8020E/8020P*, DP-180/190, UF-9000)

Follow the procedure below to print a file from a Secure Mailbox on your machine.

1. Print a file to the Secure Mailbox using the User ID and a Password. (Up to 20 mailboxes per each User ID)

2. Press \[ PRINTER ON LINE \].

3. Press \[ ENTER USER ID \].

4. Enter the User ID (up to 8 digits) from the keypad. (Ex: 12345678)

5. Press \[ ENTER USER ID \].

6. \[ USE OR TO SCROLL \] repeatedly until the display shows the file you want to print.

7. Press \[ ENTER PASSWORD \].

8. Enter the Password (4 digits) from the keypad. (Ex: 1234)

9. Press \[ ENTER PASSWORD \].

10. Press \[ SECURE MAILBOX \] repeatedly until the display shows 1:PRINT 2:DELETE.

11. Press \[ PC DATA \].

Your machine will print the file. The file is automatically deleted after printing.
## Deleting from the Secure Mailbox

Follow the procedure below to delete a file from a Secure Mailbox on your machine.

1. Press **PRINT**.

2. Press **FUNCTION** + **SET**.

3. Enter the User ID (up to 8 digits) from the keypad. *(Ex: 12345678)*

4. Press **SET**.

5. Press **↑** or **↓** repeatedly until the display shows the file you want to delete.

6. Press **SET**.

7. Enter the Password (4 digits) from the keypad. *(Ex: 1234)*

8. Press **SET**.

9. Press **FUNCTION**.

10. Press **STOP**.

---

![Screen Display](image)

**ENTER USER ID**

**ENTER USER ID 12345678**

**USE OR TO SCROLL**

**TOTAL DOC=nn**

**ENTER USER ID 12345678**

*(Panasonic) 10:11 (Pana.doc)*

**ENTER PASSWORD ******

**SECURE MAILBOX 1:PRINT 2:DELETE**

**DELETE DOCUMENT? 1:YES 2:NO**

**PRINTER ON LINE**

---

35
Job Queue (For DP-8020E/8020P*, DP-180/190, UF-9000)

Follow the procedure below to verify the print jobs.

1. Press PRINT.

2. Press FUNCTION ③ SET.

3. Press SET.

4. ▲ or ▼ repeatedly until the display shows the file you want to print.

5. Press SET.

6. Enter the Password (3 digits) from the keypad. (Ex: 123)

7. Press SET.

8. ① to change the print job priority. ② to delete the print file. ③ to delete all print files. Ex: ②

9. Press ① STOP.
Memo
Printing from Macintosh Applications

Basic Operation

To print using the Macintosh application, select Print from the File menu, and open the following print dialog box. Functions appear on the print dialog box may differ depending on the application / operating system you are using.

For OS 8.6/9.x

- Click the Save Settings button to save the current settings for the default value.
For OS X

- Select **Save As.../Save Custom Setting** (For OS X 10.1) from the **Presets** to save the current settings for the default value.

(OS X 10.1)

(OS X 10.2)
Printing from Macintosh Applications (OS X 10.3)

Note:

- When multiple printers are installed in your PC, select the desired printer in the **Printer** menu on top of the screen.
- For some applications, the Paper Feed setting may not be reflected on the actual output. Please refer to the readme file for the details.
For OS 8.6/9.x
- Click the [Save Settings] button to save the current settings for the default value.

For OS X
- Select [Save As…]/[Save Custom Setting] (For OS X 10.1) from the [Presets] to save the current settings for the default value.
Click the **Preview** button to check that the print options are set correctly.

Click the **Save As PDF** button to save the document as PDF file instead of printing on sheets of paper.

**Note:**
Configuring the Printer Driver Settings (For Mac OS 8.6/9.x)

Opening the Print Dialog Box
To change the printer settings, open the dialog box for the printer properties by performing the following steps.

1. Select the File menu > Print.

2. Select the Printer.

![Print Dialog Box](image)
In the print dialog box, you will see a number of titles in the pop-up menu. Select the desired menu title(s), and configure the properties as necessary. Click the **Save Settings** button to save the current settings for the default values.

**General / Background Printing / Cover Page / Color Matching / Layout / Error Handling / PostScript Settings menus:**
These menus are Macintosh, or Adobe® PostScript specific settings. Refer to Macintosh manuals, help topics, and/or Online Support.

**Output / Quality / Printer Specific Options menus:**
These menus are **Panasonic Printing System** associated settings. For additional details, refer to the page(s) relevant to the subject you are interested in.

- Output Menu : See page 46
- Quality Menu : See page 49
- Printer Specific Options Menu : See page 53
Output Menu

Output menu is used for configuring output settings.

(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

(For DP-8060/8045/8035)

(For DP-8032/8025, DP-3030/2330)
1. **Collation**
   Specified the Off/On for Collation.

   Specified the Output Tray.
   (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)
   - **Automatically Select**
     - **Inner Tray** Sends printed jobs to the Inner tray.
     - **Outer Tray** Sends printed jobs to the Outer tray.
     (Selection only displays if the printer is equipped with an Outer tray)
     - **Finisher** Sends printed jobs to the Finisher.
     (Selection only displays if the printer is equipped with a Finisher)
   (For DP-8060/8045/8035)
   - **Bin 1** Sends printed jobs to the Bin 1.
   - **Bin 2** Sends printed jobs to the Bin 2.

   **Note:**
   - You can only select **Bin 1/ Bin 2** for the output tray.

   (For DP-8032/8025, DP-3030/2330)
   - **Auto Selection**
     - **Automatically selects one of the following Output Trays.**
     - **Inner Tray** Sends printed jobs to the Inner tray 1 (Lower), Inner tray (Upper).
     - **Outer Tray** Sends printed jobs to the Outer tray.
     (Selection only displays if the printer is equipped with an Outer tray)
     - **Finisher** Sends printed jobs to the Finisher.
     (Selection only displays if the printer is equipped with a Finisher)

   **Note:**
   - **Finisher Bin/Output Tray** is not available for DP-8020E/8020P*, DP-180/190, UF-9000.

*Continue on the next page...*
3. Sort/Sort Method

Specifies how pages are sorted when multiple copies are printed.

**Note:**
- **Shift** is available only if the printer is equipped with a Finisher.
- **Rotate** is available only when **Paper Source** is set to **Auto Select**.
- **Rotate** requires paper of the specified size to be loaded in two trays, loaded for Landscape and Portrait printing.
- **Shift** is not available for DP-8020E/8020P*.
- **Sort** may not be available with certain paper sizes.

<table>
<thead>
<tr>
<th>Non Sort(Stack)</th>
<th>Print individual pages in the specified quantity. For example, if you print three copies of a five-page document, the printer prints page 1 three times before printing page 2 and so on.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort</td>
<td>Copies are stacked in the order they are printed. Multiple copies are printed in separate sets in the specified quantity. For example, if you print three copies of a five-page document, the printer prints pages 1-5 three times.</td>
</tr>
<tr>
<td>Rotate Stack</td>
<td>Each set is rotated, and stacked uniformly.</td>
</tr>
<tr>
<td>Rotate Sort</td>
<td>Each set is rotated, and sorted.</td>
</tr>
<tr>
<td>Shift Stack</td>
<td>Each set is shifted, and stacked uniformly.</td>
</tr>
<tr>
<td>Shift Sort</td>
<td>Each set is shifted, and sorted.</td>
</tr>
</tbody>
</table>

4. Staple

Specifies the position of the staple.

**Left 1, Left 2, Right 1, Right 2, Top 2** or **Saddle Stitch** (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213, DP-8060/8045/8035)

**Left 1, Right 1** (For DP-8032/8025 and DP-3030/2330)

**Note:**
- **Staple** is only available if the printer is equipped with an optional Finisher.
- **Available staple position may be different depending on the Finishes.**
- **The staple capacity differ depending on the types of Finisher and the paper size. Refer to Specifications in the Operating Instructions (For Basic Function) provided on another booklet.**
- **When setting the staple position to Saddle Stitch, set paper in Landscape position.**
- **Staple** is not available for DP-8020E/8020P*, DP-180/190, UF-9000.
- **Do not use **Stack, Rotate, and Shift**.**
- **Some staple positions may not be available with certain punch position combinations. (For example, when selecting **TopRight** for the staple position and **Bottom** for the punch position.)**
- **Staple** may not be available with certain paper sizes.

5. Punch

Specifies the hole punch position.

**Note:**
- Only available if the printer is equipped with an optional Finisher, and Punch Unit.
- The paper size for which hole punching can be performed differ depending on the types of Finisher.
- **Punch** is not available for DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, and UF-9000.
- **Do not use **Rotate and Shift**.**
- **Some punch positions may not be available with certain staple position combinations. (For example, when selecting **TopRight** for the staple position and **Bottom** for the punch position.)**
- **Punch** may not be available with certain paper sizes.
Quality Menu

Quality menu configures the settings that determine the print quality.

(For DP-C354/C264/C323/C263/C213)

(For DP-C405/C305/C265)

(scroll the dialog box)

(For DP-C354/C264/C323/C263/C213)
Printing from Macintosh Applications

(For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330)

(For DP-8020E/8020P*)

(For DP-180/190, UF-9000)
1. **Media Type**
   Specifies the type of paper. Paper Feed method (Tray or Multi-Purpose Tray) differ depending on the Media Type (Plain Paper, Thick Paper, etc.) selected. See below for the Media Type.

   **For DP-C405/C305/C265**

   **For DP-C354/C264/C323/C263/C213**

   **For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330**
   Plain Paper, Thick Paper

   **For DP-8020E/8020P**
   Plain Paper, Thick Paper, Transparency, Envelope

   **For DP-180/190, UF-9000**
   Plain Paper, Thick Paper, Transparency, Label, Cotton Paper, Envelope

2. **Resolution**
   Specifies the printing resolution. Choosing a higher resolution improves the print quality but slows printing.

   (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Prints at a print engine resolution of <strong>600×600 dpi</strong>.</td>
</tr>
<tr>
<td>Enhance</td>
<td>Prints at a print engine resolution of <strong>1200×1200 dpi</strong>.</td>
</tr>
</tbody>
</table>

   **Note for DP-C405/C305/C265, DP-C354/C264/C323/C263/C213:**
   - Printing takes more time when **Enhance** is selected.
   - **Enhance** is not available when the Media Type is set to Transparency.

   (For DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>300×300dpi</td>
<td>Prints at a print engine resolution of <strong>300×300 dpi</strong>.</td>
</tr>
<tr>
<td>600×600dpi</td>
<td>Prints at a print engine resolution of <strong>600×600 dpi</strong>.</td>
</tr>
<tr>
<td>1200×600dpi</td>
<td>Prints at a print engine resolution of <strong>1200×600 dpi</strong>.</td>
</tr>
</tbody>
</table>

   Specifies whether to print in color or grayscale.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Prints documents in color.</td>
</tr>
<tr>
<td>Photo Color</td>
<td>Prints photos with the optimal settings.</td>
</tr>
<tr>
<td>Grayscale</td>
<td>Prints documents in monochrome.</td>
</tr>
</tbody>
</table>

   **Note:**
   - **Photo Color** mode takes more time to print a file.
   Specifies color settings to fine-tune color reproduction.
   
<table>
<thead>
<tr>
<th>Device Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Select None when using ICM or application’s color management.</td>
</tr>
<tr>
<td>SWOP</td>
<td>Simulates printing to a standard American offset press.</td>
</tr>
<tr>
<td>Euroscale</td>
<td>Simulates printing to an European offset press.</td>
</tr>
</tbody>
</table>

   Specifies color reproduction and Black output for text, graphics and images.
   
<table>
<thead>
<tr>
<th>Standard Profile with Black Gray</th>
<th>Print with color reproduction close to standard color monitors. Use only Black to reproduce intermediate shades of gray.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vivid Profile with Black Gray</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Use only Black to reproduce intermediate shades of gray.</td>
</tr>
<tr>
<td>Standard Profile with CMYK Gray</td>
<td>Print with color reproduction close to standard color monitors. Uses four colors of CMYK to reproduce intermediate shades of gray.</td>
</tr>
<tr>
<td>Vivid Profile with CMYK Gray</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Uses four colors of CMYK to reproduce intermediate shades of gray.</td>
</tr>
</tbody>
</table>

   Choose On to conserve toner. The overall effect is lighter, so this feature is recommended for test printing or producing documents for which appearance is not critical.

   Color brightness is adjustable. 100% is normal brightness. Brightness darkens as the numerical value grows.
Printer Specific Options Menu

Printer Specific Options menu is used for configuring Panasonic Printing System associated settings.

1. Secure

Printed documents can be saved on the printer’s hard disk drive (HDD) if the printer is equipped with one. Saved documents can be printed from the printer’s control panel. See "Mailbox Printing" on page 26. When using the Mailbox printing function, check the HDD Unit in "Installable Options". For details, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)".

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Mailbox printing is not applied.</td>
</tr>
<tr>
<td>Check then Print</td>
<td>Allows you to print one proof set, before proceeding to print a large multi-set with various settings. The documents data will be deleted from the printer after printing.</td>
</tr>
<tr>
<td>Mailbox</td>
<td>Saves print data in the printer, in the mailbox specified by the User ID. The User ID must be entered to print documents saved in Mailbox. The document data will remain in the printer until it is deleted.</td>
</tr>
<tr>
<td>Secure Mailbox</td>
<td>Saves print data in the printer, in the mailbox specified by the User ID. The User ID and Password must be entered to print confidential documents saved in Secure Mailbox. The document data will remain in the printer until it is deleted.</td>
</tr>
</tbody>
</table>

Note:
- Using Mailbox printing requires that the Hard Disk Drive Unit is installed in the printer.
- For details, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)".
- Check then Print function is not available for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000.
- Do not use Stack.

2. Print Blank Pages

Choose On to enable printing Blank pages.

Note:
- The Print Blank Pages is not selectable if the Print on Both Sides is set to be enabled on the Layout menu.
- The paper size for which hole punching can be performed differ depending on the types of Finisher.

3. Front/Back Cover or Front/Back Cover Page

You can configure the settings for cover pages. To use a cover page, select Front Cover/Front Cover Page or Back Cover/Back Cover Page, and specify the paper source to use for pages for the Front and Back covers.

4. Duplex Notice

Check whether “2-Sided Print” is printed on the footer of 1st page when printing with 2-Sided Page style.

Note:
- This option is available only for DP-8032/8025, DP-3030/2330.
- The position where the notice is to be printed may differ depending on the Page Setup/Orientation (Landscape) setting.
Configuring the Printer Driver Settings (For Mac OS X)

Opening the Print Dialog Box
To change the printer settings, open the dialog box for the printer properties by performing the following steps.

1 Select the File menu > Print.

2 Select the Panasonic printer.
Printing from Macintosh Applications

(OS X 10.2)

(OS X 10.3)

(OS X 10.4)
In the print dialog box, you will see a number of titles in the pop-up menu. Select the desired menu title(s), and configure the properties as necessary. Select Save Custom Setting menu to save the current settings for the default values.

Copies & Pages / Layout / Duplex / Output Options / Scheduler / Paper Handling / ColorSync / Cover Page / Error Handling / Paper Feed / Summary menus

Note: Available menus may differ, depending on the type of OS you are using.

These menus are Macintosh or Adobe PostScript specific settings. Refer to Macintosh manuals, help topics, and/or Online Support.

Printer Features menu:
There are four kinds of Feature Sets in the Printer Features menu. These are Panasonic Printing System associated settings. For additional details, refer to the page(s) relevant to the subject you are interested in.

Output Menu: See page 57
Quality_1 Menu: See page 61
Quality_2 Menu: See page 68
Miscellaneous Menu: See page 70

Note: For 10.1.x, some items cannot be selected, and some of the already set items may not function. For OS X 10.1.x, refer to the support on the website of Apple, Inc., or contact Apple, Inc..
**Output Menu (in Printer Features Menu)**

*Output* menu is used for configuring output settings. The screens displayed differ depending on the type of OS and machine you are using. Several examples of the screens are shown below with explanations for each setting. Select the settings according to the screens displayed on your PC.

(OS X 10.1)

(OS X 10.2)
1. Finisher Bin (DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)/
   Output Tray (DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330)
   Specifies the Output Tray.
   (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

<table>
<thead>
<tr>
<th>Automatically Select</th>
<th>Automatically selects one of the following Output trays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Tray</td>
<td>Sends printed jobs to the Inner tray.</td>
</tr>
<tr>
<td>Outer Tray</td>
<td>Sends printed jobs to the Outer tray.</td>
</tr>
<tr>
<td>Finisher</td>
<td>Sends printed jobs to the Finisher.</td>
</tr>
<tr>
<td></td>
<td>(Selection only displays if the printer is equipped with an Outer tray)</td>
</tr>
<tr>
<td></td>
<td>(Selection only displays if the printer is equipped with a Finisher)</td>
</tr>
</tbody>
</table>

   **Note:**
   - Do not use **Shift**, **Staple**, and **Punch** when using the Inner or Outer tray.

   (For DP-8060/8045/8035)

<table>
<thead>
<tr>
<th>Bin 1</th>
<th>Sends printed jobs to the Bin 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bin 2</td>
<td>Sends printed jobs to the Bin 2.</td>
</tr>
</tbody>
</table>

   **Note:**
   - You can only select **Bin 1** / **Bin 2** for the output tray.

   (For DP-8032/8025, DP-3030/2330)

<table>
<thead>
<tr>
<th>Auto Selection</th>
<th>Automatically selects one of the following Output Trays.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner Tray</td>
<td>Sends printed jobs to the Inner Tray 1 (Lower), Inner Tray 2 (Upper).</td>
</tr>
<tr>
<td>Outer Tray</td>
<td>Sends printed jobs to the Outer tray.</td>
</tr>
<tr>
<td>Finisher</td>
<td>Sends printed jobs to the Finisher.</td>
</tr>
<tr>
<td></td>
<td>(Selection only displays if the printer is equipped with an Outer tray)</td>
</tr>
<tr>
<td></td>
<td>(Selection only displays if the printer is equipped with a Finisher)</td>
</tr>
</tbody>
</table>

   **Note:**
   - **Inner Tray 2 (Upper)**, **Outer Tray** and **Finisher** are not available for OS 10.1.
   - **Finisher Bin/Output Tray** is not available for DP-8020E/8020P*, DP-180/190, UF-9000.

2. Sort /Sort Method
   Specifies how pages are sorted when multiple copies are printed.

<table>
<thead>
<tr>
<th>Non Sort(Stack)</th>
<th>Print individual pages in the specified quantity. For example, if you print three copies of a five-page document, the printer prints page 1 three times before printing page 2 and so on.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort</td>
<td>Copies are stacked in the order they are printed. Multiple copies are printed in separate sets in the specified quantity. For example, if you print three copies of a five-page document, the printer prints pages 1-5 three times.</td>
</tr>
<tr>
<td>Rotate Stack</td>
<td>Each set is rotated, and stacked uniformly.</td>
</tr>
<tr>
<td>Rotate Sort</td>
<td>Each set is rotated, and sorted.</td>
</tr>
<tr>
<td>Shift Stack</td>
<td>Each set is shifted, and stacked uniformly.</td>
</tr>
<tr>
<td>Shift Sort</td>
<td>Each set is shifted, and sorted.</td>
</tr>
</tbody>
</table>

   **Note:**
   - **Shift** is available only if the printer is equipped with a Finisher.
   - **Rotate** requires paper of the specified size to be loaded in two trays, loaded for Landscape and Portrait printing.
   - **Shift Stack** and **Shift Sort** are not available for OS X 10.1.x.

   Continue on the next page...
3. **Staple**

   Specifies the position of the staple. Choose the position from

   **Left 1, Left 2, Right 1, Right 2, Top 2** or **Saddle Stitch** (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213, DP-8060/8045/8035)

   **Left 1, Right 1** (For DP-8032/8025, DP-3030/2330)

   **Note:**
   - Only available if the printer is equipped with an optional Finisher.
   - Available staple position may be different depending on the Finishers.
   - The staple capacity differ depending on the types of Finisher and the paper size. Refer to Specifications in the Operating Instructions (For Basic Function) provided on another booklet.
   - Do not choose Saddle Stitch as the Booklet mode is not available for Mac OS X.
   - **Staple** is not available for OS X 10.1.x.
   - **Staple** is not available for DP-8020E/8020P*, DP-180/190, UF-9000.
   - Do not use **Stack**, **Rotate**, and **Shift**.
   - Some staple positions may not be available with certain punch position combinations. (For example, when selecting **Top Right** for the staple position and **Bottom** for the punch position.)

4. **Punch**

   Specifies the hole punch position.

   **Note:**
   - Only available if the printer is equipped with an optional Finisher and Punch Unit.
   - The paper size for which hole punching can be performed differ depending on the types of Finisher.
   - **Punch** is not available for OS X 10.1.x.
   - **Punch** is not available for DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000.
   - Do not use **Rotate** and **Shift**.
   - Some punch positions may not be available with certain staple position combinations. (For example, when selecting **Top Right** for the staple position and **Bottom** for the punch position.)
Quality_1 Menu (in Printer Features Menu) (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)


Quality_1 / Quality menu configures the settings that determine the print quality.

(OS X 10.1 for DP-C405/C305/C265)

(OS X 10.1 for DP-C354/C264/C323/C263/C213)

(OS X 10.1 for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*)

(OS X 10.1 for DP-180/190, UF-9000)
Printing from Macintosh

Applications (OS X 10.2 for DP-C405/C305/C265)

(OS X 10.2 for DP-C354/C264/C323/C263/C213)

(OS X 10.2 for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*)

(OS X 10.2 for DP-180/190, UF-9000)
Printing from Macintosh Applications

(OS X 10.3 for DP-C405/C305/C265)

(OS X 10.3 for DP-C354/C264/C323/C263/C213)

(OS X 10.3 for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*)

(OS X 10.3 for DP-180/190, UF-9000)
Printing from Macintosh Applications

(OS X 10.4 for DP-C405/C305/C265)

(OS X 10.4 for DP-C354/C264/C323/C263/C213)

(OS X 10.4 for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*)

(OS X 10.4 for DP-180/190, UF-9000)
Printing from Macintosh Applications

(OS X 10.5 for DP-C405/C305/C265)

(OS X 10.5 for DP-C354/C264/C323/C263/C213)

(OS X 10.5 for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*)

(OS X 10.5 for DP-180/190, UF-9000)
1. **Media Type**
   Specifies the type of paper. Paper Feed method (Tray or Multi-Purpose Tray) may differ depending on the Media Type (Plain Paper, Thick Paper, etc.) selected. See below for the Media Type.

**For DP-C405/C305/C265**

**For DP-C354/C264/C323/C263/C213**

**For DP-8060/8045/8035, DP-8032/8025 and DP-3030/2330**
Plain Paper, Thick Paper

**For DP-8020E/8020P**
Plain Paper, Thick Paper, Transparency, Envelope

**For DP-180/190, UF-9000**
Plain Paper, Thick Paper, Transparency, Label, Cotton Paper, Envelope

2. **Resolution**
   Specifies the printing resolution. Choosing a higher resolution improves the print quality but slows printing.

(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Prints at a print engine resolution of 600×600 dpi.</td>
</tr>
<tr>
<td>Enhance</td>
<td>Prints at a print engine resolution of 1200×1200 dpi.</td>
</tr>
</tbody>
</table>

**Note for DP-C405/C305/C265, DP-C354/C264/C323/C263/C213:**
*Printing takes more time when Enhance is selected.*

(For DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>300×300dpi</td>
<td>Prints at a print engine resolution of 300×300 dpi.</td>
</tr>
<tr>
<td>600×600dpi</td>
<td>Prints at a print engine resolution of 600×600 dpi.</td>
</tr>
<tr>
<td>1200×600dpi</td>
<td>Prints at a print engine resolution of 1200×600 dpi.</td>
</tr>
</tbody>
</table>

   Specifies whether to print in color or grayscale.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Prints documents in color.</td>
</tr>
<tr>
<td>Photo Color</td>
<td>Prints photos with the optimal settings.</td>
</tr>
<tr>
<td>Grayscale</td>
<td>Prints documents in monochrome.</td>
</tr>
</tbody>
</table>

**Note:**
*Photo Color mode takes more time to print a file.*

   Specifies color settings to fine-tune color reproduction.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Color</td>
<td>Choose this option to adjust the original color settings.</td>
</tr>
<tr>
<td>None</td>
<td>Select None when using ICM or application’s color management.</td>
</tr>
<tr>
<td>SWOP</td>
<td>Simulates printing to a standard American offset press.</td>
</tr>
<tr>
<td>Eurosclae</td>
<td>Simulates printing to an European offset press.</td>
</tr>
</tbody>
</table>

Specifies color reproduction and Black output for text, graphics and images.

<table>
<thead>
<tr>
<th>Standard Profile with Black Gray</th>
<th>Print with color reproduction close to standard color monitors. Use only Black to reproduce intermediate shades of gray.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vivid Profile with Black Gray</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Use only Black to reproduce intermediate shades of gray.</td>
</tr>
<tr>
<td>Standard Profile with CMYK Gray</td>
<td>Print with color reproduction close to standard color monitors. Use the four colors of CMYK to reproduce intermediate shades of gray.</td>
</tr>
<tr>
<td>Vivid Profile with CMYK Gray</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Use the four colors of CMYK to reproduce intermediate shades of gray.</td>
</tr>
</tbody>
</table>

6. **Print as mirror image (Available for DP-C405/C305/C265)**

Select "Print as mirror image" to print the documents in mirror image.

**Note:**
- *This function is not featured for OS X 10.1.*

7. **Toner Save (Available for DP-180/190, UF-9000)**

The overall effect is lighter, so this feature is recommended for test printing or producing documents for which appearance is not critical.

**Note:**
- *For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213, this function is available on the Quality 2.*
Quality_2 Menu (in Printer Features Menu) (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

Quality_2 menu configures the settings that determine the print quality.

(OS X 10.1 for DP-C405/C305/C265)

(OS X 10.1 for DP-C354/C264/C323/C263/C213)

(OS X 10.2 for DP-C405/C305/C265)

(OS X 10.2 for DP-C354/C264/C323/C263/C213)

(OS X 10.3 for DP-C405/C305/C265)

(OS X 10.3 for DP-C354/C264/C323/C263/C213)
1. Device Color Space for Text/Graphics/Image

Specifies color reproduction and Black output for text, graphics and images.

<table>
<thead>
<tr>
<th>Standard Profile with Black Gray</th>
<th>Vivid Profile with Black Gray</th>
<th>Standard Profile with CMYK Gray</th>
<th>Vivid Profile with CMYK Gray</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print with color reproduction close to standard color monitors. Use only Black to reproduce intermediate shades of gray.</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Use only Black to reproduce intermediate shades of gray.</td>
<td>Print with color reproduction close to standard color monitors. Use the four colors of CMYK to reproduce intermediate shades of gray.</td>
<td>Print with more vivid color reproduction. A good choice for line art and graphics. Use the four colors of CMYK to reproduce intermediate shades of gray.</td>
</tr>
</tbody>
</table>

2. Toner Save

Choose On to conserve toner. The overall effect is lighter, so this feature is recommended for test printing or producing documents for which appearance is not critical.

3. Brightness

Color brightness is adjustable. 100% is normal brightness. Brightness darkens as the numerical value grows.

Miscellaneous Menu (in Printer Features Menu)

**Miscellaneous** menu is used for configuring Panasonic Printing System associated settings.


(OS X 10.1 for DP-8032/8025, DP-3030/2330)
Printing from Macintosh Applications

(OS X 10.2 for DP-C405/C305/C265, DP-C354/C264/C323/C263/C213, DP-8060/8045/8035)

(OS X 10.2 for DP-8032/8025, DP-3030/2330)

(OS X 10.2 for DP-8020E/8020P*, DP-180/190, UF-9000)
Printing from Macintosh Applications


(OS X 10.3 for DP-8032/8025, DP-3030/2330)
Printing from Macintosh Applications


(OS X 10.4 for DP-8032/8025, DP-3030/2330)
Printing from Macintosh Applications


(OS X 10.5 for DP-8060/8045/8035)

(OS X 10.5 for DP-8032/8025, DP-3030/2330)
1. Secure
Printed documents can be saved on the printer's optional hard disk drive (HDD) if the printer is equipped with one. Saved documents can be printed from the printer's control panel. See "Mailbox Printing" on page 26. When using the mailbox printing function, check the HDD Unit in "Installable options". For details, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)".

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Mailbox printing is not applied.</td>
</tr>
<tr>
<td>Check Then Print</td>
<td>Allows you to print one proof set, before proceeding to print a large multi-set with various settings. The documents data will be deleted from the printer after printing.</td>
</tr>
<tr>
<td>Mailbox</td>
<td>Saves print data in the printer, in the mailbox specified by the User ID. The User ID must be entered to print documents saved in Mailbox. The document data will remain in the printer until it is deleted.</td>
</tr>
<tr>
<td>Secure Mailbox</td>
<td>Saves print data in the printer, in the mailbox specified by the User ID. The User ID and Password must be entered to print confidential documents saved in Secure Mailbox. The document data will remain in the printer until it is deleted.</td>
</tr>
</tbody>
</table>

**Note:**
- Using Mailbox printing requires that the optional Hard Disk Drive Unit is installed in the printer. For details, refer to the "Operating Instructions (For Setting Up PostScript3 Printer Driver)".
- Secure is not available for OS X 10.1.x.
- Do not use Stack.

2. Print Blank Pages
Click on the checkbox to enable printing Blank pages.

3. Front/Back Cover or Front/Back Cover Page
You can configure the settings for cover pages. To use a cover page, select Front Cover/Front Cover Page or Back Cover/Back Cover Page, and specify the paper source to use for pages for the Front and Back covers.

4. Duplex Notice
Check whether "2-Sided Print" is printed on the footer of 1st page when printing with 2-Sided Page style.

**Note:**
- This option is available only for DP-8032/8025, DP-3030/2330.
- The position where the notice is to be printed may differ depending on the Page Setup/Orientation (Landscape) setting.

5. Tray Switching (Available for DP-8060/8045/8035, DP-8032/8025, DP-3030/2330)
Allows the paper to be fed continuously if the same size of paper is loaded in another paper tray. This function cannot be disabled.
### Specifications (For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

<table>
<thead>
<tr>
<th>Printing Speed (A4/Letter size, Plain paper from Paper Tray, 600dpi, Simplex printing)</th>
<th>DP-C405</th>
<th>DP-C305</th>
<th>DP-C265</th>
<th>DP-C354</th>
<th>DP-C323</th>
<th>DP-C264</th>
<th>DP-C263</th>
<th>DP-C213</th>
</tr>
</thead>
</table>

- **Resolution (dots per inch)**: 600 x 600, 1200 x 1200
- **Interface**: USB 2.0, Ethernet (10Base-T/100Base-TX)
- **Printer Language**: Adobe® PostScript® 3™
- **Fonts**: 136 Typeface fonts
- **Operating System Support**: Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Mac OS 8.6/9.x, Mac OS X 10.1 - 10.5, NetWare® 3.x, NetWare® 4.x, NetWare® 5.x, NetWare® 6 (Required IPX/SPX setup utility)
- **Network Printing Protocol Support**: LPR, IPP, SMB, Standard TCP/IP Port Printing (RAW/LPR), NetWare®, EtherTalk
- **Printer Working Memory**: 64MB (240MB: When memory is expanded.)
### Specifications (For DP-8060/8045/8035)

| Printing Speed  | DP-8060  : 60 sheets/minute  
|                 | DP-8045  : 45 sheets/minute  
|                 | DP-8035  : 35 sheets/minute  
| Resolution      | 300 x 300, 600 x 600, 1200 (Equivalent) x 600  
| Interface       | Parallel Port  
|                | Ethernet (10Base-T/100Base-TX)  
| Printer Language| Adobe® PostScript® 3™  
| Fonts           | 136 Typeface fonts  
| Operating System Support | Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Mac OS 8.6/9.x, Mac OS X 10.1 - 10.5, NetWare 3.x, NetWare 4.x, NetWare 5.x, NetWare 6 (Required IPX/SPX setup wizard)  
| Network Printing Protocol Support | LPR, IPP (Option: PCL or PS option is required), Standard TCP/IP Port Printing (RAW/LPR), NetWare (Note), EtherTalk (PS option is required)  
| Printer Working Memory | 50MB  

### Specifications (For DP-8032/8025)

| Printing Speed  | DP-8032  : 32 sheets/minute  
|                 | DP-8025  : 25 sheets/minute  
| Resolution      | 300 x 300, 600 x 600, 1200 x 600  
| Interface       | USB connection  
|                | Ethernet (10Base-T/100Base-TX)  
| Printer Language| Adobe® PostScript® 3™  
| Fonts           | 136 Typeface fonts  
| Network Printing Protocol Support | LPR, IPP (Option: PCL or PS option is required), Standard TCP/IP Port Printing (RAW/LPR), NetWare (Note), EtherTalk (PS option is required)  
| Printer Working Memory | 50MB  

---

**Note:**
- LPR, IPP (Option: PCL or PS option is required), Standard TCP/IP Port Printing (RAW/LPR), NetWare (Note), EtherTalk (PS option is required)
### Specifications (For DP-3030/2330)

| Printing Speed (A4/Letter size, Plain paper, simplex printing) | DP-3030 : 30 sheets/minute  
| | DP-2330 : 23 sheets/minute  
| Resolution (dots per inch) | 300 x 300, 600 x 600, 1200 x 600  
| Interface | USB connection  
| | Ethernet (10Base-T/100Base-TX)  
| Printer Language | Adobe® PostScript® 3™  
| Fonts | 136 Typeface fonts  
| Operating System Support | Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Mac OS 8.6/9.x, Mac OS X 10.1 - 10.5, NetWare 3.x, NetWare 4.x, NetWare 5.x, NetWare 6 (Required IPX/SPX setup wizard)  
| Network Printing Protocol Support | LPR, IPP (Option: PCL or PS option is required), Standard TCP/IP Port Printing (RAW/LPR), NetWare (Note), EtherTalk (PS option is required)  
| Printer Working Memory | 50MB  

### Specifications (For DP-8020E/8020P*)

| Printing Speed (A4/Letter size, Plain paper, simplex printing) | DP-8020E : 20 cpm (Letter size)  
| | DP-8020P* : 20 cpm (Letter size)  
| Resolution (dots per inch) | 300 x 300, 600 x 600, 1200 x 1200  
| Interface | USB connection  
| | Ethernet (10Base-T/100Base-TX)  
| Printer Language | Adobe® PostScript® 3™  
| Fonts | 136 Typeface fonts  
| Network Printing Protocol Support | LPR, IPP (Option: PCL or PS option is required), Standard TCP/IP Port Printing (LPR), EtherTalk (PS option is required)  
| Printer Working Memory | 20MB  

---

Appendix
## Specifications (For DP-180/190, UF-9000)

<table>
<thead>
<tr>
<th>Specifications</th>
<th>DP-180</th>
<th>DP-190</th>
<th>UF-9000</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printing Speed</strong></td>
<td>18 sheets/minute (A4 size)</td>
<td>19 sheets/minute (Letter size)</td>
<td>18 sheets/minute (A4 size)</td>
</tr>
<tr>
<td>(A4/Letter size, Plain paper, simplex printing)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>300 x 300, 600 x 600, 1200 (Equivalent) x 600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(dots per inch)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB 1.1</td>
<td>Ethernet (10Base-T/100Base-TX)</td>
<td></td>
</tr>
<tr>
<td><strong>Printer Language</strong></td>
<td>Adobe® PostScript® 3™</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fonts</strong></td>
<td>136 Typeface fonts</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Network Printing Protocol Support</strong></td>
<td>LPR, IPP (Option: PCL or PS option is required), Standard TCP/IP Port Printing (LPR), EtherTalk (PS option is required)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Printer Working Memory</strong></td>
<td>20MB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Printing Area

When printing to the device, there is a non-printable margin on all 4 sides.

Top
4.2 mm
(0.17"

Less than 4.2 mm
(0.17"

Bottom
4.2 mm
(0.17"

Unit: mm (inches)

(For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213)

Top
5 mm
(0.20"

5 mm (0.20"

Bottom
5 mm
(0.20"

Unit: mm (inches)

(For DP-8060/8045/8035, DP-8032/8025, DP-3030/2330, DP-8020E/8020P*, DP-180/190, UF-9000)
## PostScript® Font List

### PostScript® Fonts

- Albertus
- Albertus Italic
- Albertus Light
- Antique Olive Bold
- Antique Olive Compact
- Antique Olive Italic
- Antique Olive Roman
- Apple Chancery
- Arial
- Arial Bold
- Arial Bold Italic
- Arial Italic
- ITC AvantGarde Gothic Book
- ITC AvantGarde Gothic Book Oblique
- ITC AvantGarde Gothic Demi
- ITC AvantGarde Gothic Demi Oblique
- Bodoni
- Bodoni Bold
- Bodoni Bold Italic
- Bodoni Italic
- Bodoni Poster
- Bodoni Poster Compressed
- ITC Bookman Demi
- ITC Bookman Demi Italic
- ITC Bookman Light
- ITC Bookman Light Italic
- Carta
- Chicago
- Clarendon
- Clarendon Bold
- Clarendon Light
- Cooper Black
- Cooper Black Italic
- Copperplate Gothic 33BC
- Copperplate Gothic 32BC
- Coronet
- Courier
- Courier Bold
- Courier Bold Oblique
- Courier Oblique
- Eurostile
- Eurostile Bold
- Eurostile Bold Extended Two
- Eurostile Extended Two
- Geneva
- Gill Sans
- Gill Sans Bold
- Gill Sans Condensed Bold
- Gill Sans Bold Italic
- Gill Sans Condensed Italic
- Gill Sans Extra Bold
- Gill Sans Light
- Gill Sans Light Italic
- Goudy Oldstyle
- Goudy Bold
- Goudy Bold Italic
- Goudy ExtraBold
- Goudy Oldstyle Italic
- Helvetica
- Helvetica Bold
- Helvetica Condensed
- Helvetica CondensedBold
- Helvetica Condensed Bold Oblique
- Helvetica Condensed Oblique
- Helvetica Narrow
- Helvetica Narrow Bold
- Helvetica Narrow Bold Oblique
- Helvetica Narrow Oblique
- Helvetica Oblique
- Hoefler Text Black
- Hoefler Text Black Italic
- Hoefler Text Condensed
- Hoefler Text Condensed Bold
- Hoefler Text Condensed Oblique
- Hoefler Text Ornaments
- Joanna
- Joanna Bold
- Joanna Bold Italic
- Joanna Italic
- Letter Gothic
- Letter Gothic Bold
- Letter Gothic Slanted
- Letter Gothic Slanted
- ITC Lubalin Graph Book
- ITC Lubalin Graph Book Oblique
- ITC Lubalin Graph Demi
- ITC Lubalin Graph Demi Oblique
- Marigold
- ITC Mona Lisa Recut
- Monaco
- New Century Schoolbook Bold
- New Century Schoolbook Bold Italic
- New Century Schoolbook Italic
- New Century Schoolbook Roman
- New York
- Optima
- Optima Bold
- Optima Bold Italic
- Optima Italic
- Oxford
- Palatino Bold
- Palatino Bold Italic
- Palatino Italic
- Palatino Roman
- Stempel Garamond Bold
- Stempel Garamond Bold Italic
- Stempel Garamond Italic
- Stempel Garamond Roman
- ITC Symbol
- Tekton
- Times Bold
- Times Bold Italic
- Times Italic
- Times Roman
- Times New Roman
- Times New Roman Bold
- Times New Roman Bold Italic
- Times New Roman Italic
- Univers
- Univers Bold
- Univers Bold Oblique
- Univers Oblique
- Univers Light
- Univers Light Oblique
- Univers Condensed
- Univers Condensed Bold
- Univers Condensed Bold Oblique
- Univers Condensed Oblique
- Univers Extended
- Univers Extended Bold
- Univers Extended Bold Oblique
- Univers Extended Oblique
- Wingdings
- ITC Zapf Chancery Medium Italic
- ITC Zapf Dingbats

---

Adobe, PostScript, the Adobe logo and the PostScript logo are trademarks of Adobe Systems Incorporated which may be registered in certain jurisdictions.

* registered trademark of Adobe Systems Incorporated

† trademark of Linotype-Hell AG and/or its subsidiaries

§ registered trademark of Marcel Olive

® trademark of Adobe Systems Incorporated

© trademark of Apple Computer, Inc.

® trademark of AlphaOmega Typography

™ trademark of Ludas Type Foundry

® trademark of ITC (International Typeface Corporation)

™ trademark of Linotype-Hell AG and/or its subsidiaries

® registered trademark of The Monotype Corporation

™ trademark of Nebiolo
Troubleshooting

Printing Operation Failure

If the printing operation fails, check the following items first:

- The connecting cable (Parallel Port or Ethernet LAN cable) is properly connected.
- Power of the device is turned ON.
- Paper is loaded properly in the device.
- An error message is not displayed on the device. (See Note)

The above points can be verified by printing a test page. Refer to OS manuals, help topics, and/or Online Support for the procedures on test page printing.

NOTE

The status of the devices can be verified with the Device Monitor. Refer to the Operating Instructions (For Device Monitor).
## Documents Not Printing Correctly

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause / Solution(s)</th>
</tr>
</thead>
</table>
| Incorrect printing position or print is missing at the edge.           | • Paper size or printing orientation is different between the application settings, and the printer driver settings - Specify the settings again.  
  • The specified paper has not been loaded into the device - Check the settings again, or load the appropriate paper.  
  • The document margin is not sufficient.                               |
| Characters and symbols not used in documents are printed.              | Verify that the correct machine has been selected by users as the printer driver.           |
| Printing operation takes excessive time.                               | The wait time for printing operations depends on the spool settings.                        |
| Although print data is transferred to the device, it is not printed.   | • Make sure Parallel Port the printer is Online.  
  • Make sure the Parallel Port printer cable, or Ethernet LAN cable is connected properly.  
  • Restore the power if the On line LED is Off even if the Parallel Port printer cable is connected. |
| Printing stops in the middle of the run.                              | • Check whether there is a Network problem.                                                 |
| Document is not printed from the Multi-Purpose Tray (Sheet Bypass).    | • Verify the Paper Size set to the Multi-Purpose Tray (Sheet Bypass).  
  • Set the Paper Size as the following procedures.  
    1. Press the Copy key.  
    2. Select “Paper/Output Tray”, “PAPER TRAY:” or “PAPER TRAY”.  
    3. Select “Change Size/Media” or “SIZE CHANGE”.  
    4. Select the paper size and select “OK”.  
  
  **Note:**  
  • For DP-8020E/8020P*, press the “Paper Tray” key several times until the desired paper size is displayed. There is no need to press the “OK” key after pressing the “Paper Tray” key to set the paper size.  
  • Select “Auto” on step 4 if the following paper size is loaded on the Multi-Purpose Tray (Sheet Bypass). The Paper Size is automatically set properly.  
  For USA and Canada users : Ledger., Legal, Letter, Invoice  
  Except for USA and Canada users : A3, B4, FLS, A4, A5                  |
| Document is not printed correctly, and the following message is printed out instead. “This job contains Binary Data, but your printer requires a special driver setting to receive binary data on this channel.” | Verify that the Output protocol in the Device Settings is set to ASCII.                      |
## Error Messages Displayed on the Computer

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause / Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error writing to USB. Unable to write to the Specified device. (USB connection is not available for DP-8060/8045/8035)</td>
<td>Verify that the device is connected to the computer correctly. Verify that the power of the device is turned On.</td>
</tr>
<tr>
<td>Error writing to USB. Printer timeout error occurred. (USB connection is not available for DP-8060/8045/8035)</td>
<td>Verify that the power of the device is turned On. Excessive data volume or number of pages may overflow the device’s memory, disabling data reception. Increase the timeout setting value in properties (For transmission retry).</td>
</tr>
<tr>
<td>Printing is disabled due to an error in the current printer settings.</td>
<td>Differences in settings such as paper size or printing orientation exist between the application and the printer driver. Correct the settings.</td>
</tr>
</tbody>
</table>
**Error Messages Displayed on Your Machine**

For DP-C405/C305/C265, DP-C354/C264/C323/C263/C213

If a document is not printed out, an error may have occurred. From the error messages displayed on the Control Panel, it is possible to know what caused the problem, and how the problem can be taken care of.

Checking Error Messages: Press the **Print** key, select the **Job Control** button and the **Output Queue** button. Then, select the **Print History** tab. The error message(s) are shown on the Status column.

Once you know the error message, check below for the cause and solution for the error.

<table>
<thead>
<tr>
<th>Error Messages</th>
<th>Possible Cause</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Parameter Error(001)</td>
<td>The Duplex Unit does not function properly.</td>
<td>Contact to the Panasonic Authorized Dealer to maintain your machine.</td>
</tr>
<tr>
<td>Print Parameter Error(002)</td>
<td>Specified a <strong>Paper Source</strong> which is not installed on your machine.</td>
<td>• Verify the Installable option settings correctly on your printer driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify the <strong>Number of Paper Tray</strong> settings correctly on your printer driver.</td>
</tr>
<tr>
<td>Print Parameter Error(004)</td>
<td>Specified the <strong>Output Tray to Finisher</strong>. However, the Finisher Unit is not installed on the machine. Specified the <strong>Sort Method</strong> to Shift, or specified the position of the staple.</td>
<td>• Verify the Installable option settings correctly on your printer driver.</td>
</tr>
<tr>
<td>Print Parameter Error(005)</td>
<td></td>
<td>• Verify the <strong>Finisher</strong> settings correctly on your printer driver.</td>
</tr>
<tr>
<td>Error Messages</td>
<td>Possible Cause</td>
<td>Solution(s)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print Parameter Error(006)</td>
<td>Specified the hole punch position. However, the Punch Unit is not installed on the machine.</td>
<td>• Verify the Installable option settings correctly on your printer driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify the Punch Unit settings correctly on your printer driver.</td>
</tr>
<tr>
<td>Print Parameter Error(101)</td>
<td>Specified a Paper Source unable to print in Duplex. (Duplex printing is not possible from the tray set with A5 in Landscape format)</td>
<td>• Specify the tray set with the A5 in portrait format.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select <strong>Automatically Select</strong> on the <strong>Paper Source</strong> menu.</td>
</tr>
<tr>
<td>Print Parameter Error(104)</td>
<td>Specified a Paper Source unable to shift sort.</td>
<td>• Specify the tray set with the B5 in Landscape format.</td>
</tr>
<tr>
<td></td>
<td>- Only when 1 Bin Finisher is in use.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- It is not possible to shift sort with B5 in portrait format.</td>
<td></td>
</tr>
<tr>
<td>Print Parameter Error(106)</td>
<td>Specified a wrong Paper Source when printing a document with stapling.</td>
<td>• Verify the Installable option settings correctly on your printer driver.</td>
</tr>
<tr>
<td>Print Parameter Error(107)</td>
<td></td>
<td>• Verify the Finisher settings correctly on your printer driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select <strong>Automatically Select</strong> on the <strong>Paper Source</strong> menu.</td>
</tr>
<tr>
<td>Print Parameter Error(108)</td>
<td>Specified a wrong Paper Source when printing a document with punching.</td>
<td>• Verify the Installable option settings correctly on your printer driver.</td>
</tr>
<tr>
<td>Print Parameter Error(109)</td>
<td></td>
<td>• Verify the Punch Unit settings correctly on your printer driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select <strong>Automatically Select</strong> on the <strong>Paper Source</strong> menu.</td>
</tr>
<tr>
<td>Print Parameter Error(119)</td>
<td>Specified a wrong Media Type when printing a document with Rotate sorting.</td>
<td>• Verify the Media Type setting on your machine.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select the same media type on the printer driver as set on your machine.</td>
</tr>
<tr>
<td>Printer Parameter Error(125)</td>
<td>Specified to staple documents of different document sizes.</td>
<td>• Cancel <strong>Staple</strong>, and try print again.</td>
</tr>
<tr>
<td>Printer Parameter Error(126)</td>
<td>Specified to Punch documents of different document sizes.</td>
<td>• Cancel <strong>Punch</strong>, and try print again.</td>
</tr>
</tbody>
</table>
WARRANTY

PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA MAKES NO WARRANTIES, GUARANTEES OR REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH RESPECT TO THIS PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA ASSUMES NO RISK AND SHALL NOT BE SUBJECT TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS SUSTAINED BY THE CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS PANASONIC MACHINE. SEE YOUR DEALER FOR DETAILS OF DEALER'S WARRANTY.

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):

Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA MAKES NO WARRANTIES, GUARANTEES OR REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH RESPECT TO THIS PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA ASSUMES NO RISK AND SHALL NOT BE SUBJECT TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS SUSTAINED BY THE CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS PANASONIC MACHINE. SEE YOUR DEALER FOR DETAILS OF DEALER'S WARRANTY.

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

Panasonic Communications Company of North America

Panasonic Canada Inc.

For Customer Support (Except for USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan

http://panasonic.net

For Service, Call:

Panasonic Communications Company of North America,